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Abstract

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office Release 9.1 to interoperate with the
Windstream SIP Trunking Service.

The Windstream SIP Trunking Service provides PSTN access via a SIP trunk between the
enterprise and the Windstream network as an alternative to legacy analog or digital trunks.
This approach generally results in lower cost for the enterprise. Windstream is a member of
the Avaya DevConnect Service Provider program.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office Release 9.1 to interoperate with the
Windstream SIP Trunking Service.

The Windstream SIP Trunking Service will enable delivery of origination and termination of
local, long-distance and toll-free traffic across a single broadband connection. A SIP signaling
interface will be enabled to the Customer Premises Equipment (CPE).

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site via the public Internet and
exercise the features and functionality listed in Section 2.1. The simulated enterprise site was
comprised of Avaya IP Office and various Avaya endpoints listed in Section 4.

The Windstream SIP Trunking Service passed compliance testing with any observations or
limitations described in Section 2.2.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e Establishment of the SIP trunk

e Sending SIP OPTIONS queries to the service provider

e Incoming PSTN calls (via the Windstream SIP trunk) to SIP and H.323 telephones at the
enterprise

e Outgoing PSTN calls (via the Windstream SIP trunk) from SIP and H.323 telephones at
the enterprise

¢ Inbound and outbound PSTN calls to/from Avaya Communicator for Windows

Various call types including: local, long distance, outbound toll-free, international (011 +

country code + number) and local directory assistance (411)

Codecs G.711MU and G.729A

Caller ID presentation and Caller ID restriction

DTMF transmission using RFC 2833

Response to incomplete call attempts and trunk errors

Voicemail navigation using DTMF input for inbound and outbound calls

Voicemail message waiting indicator (MWI)
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e User features such as hold and resume, internal call forwarding, transfer, and conference
e Off-net call forwarding and twinning
e G.711 fax

Emergency calls (911) and inbound toll-free calls are supported but were not tested as part of the
compliance test. Windstream does not support T.38 fax.

2.2. Test Results

Interoperability testing of the Windstream SIP Trunking Service was completed with successful
results for all test cases with the exception of the observations/limitations described below.

e Redirected calls using the SIP REFER method results in “500 Internal Server
Error” response from Windstream: If the use of REFER is enabled on Avaya IP
Office, then Avaya IP Office will send a REFER message to Windstream when a PSTN
call is forwarded or transferred to another PSTN destination. The expectation is that
Windstream will connect the two PSTN endpoints together allowing Avaya IP Office to
drop out of the call. Instead, Windstream returns a “500 Internal Server Error” response.
Avaya IP Office stays in the middle of the call allowing the forwarded or transferred call
to complete successfully. However, the Avaya IP Office trunk resources will not be
released until the call is terminated, in the same manner as if REFER was disabled. Thus,
it is recommended that REFER be disabled on Avaya IP Office for this solution. (Section
5.4.2)

2.3. Support
For technical support on the Windstream SIP Trunking Service, please contact Windstream via
the following:

e \Web: http://www.windstreambusiness.com/customer/support
e Telephone: (866) 445-5882

Andy Tran of Windstream reviewed this document on behalf of Windstream.
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3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the Windstream SIP Trunking
Service.

The enterprise site contains an Avaya IP Office 500 V2 with various endpoints and a Windows 7
machine running both Avaya IP Office Manager to configure Avaya IP Office and Avaya
VoiceMail Pro for voicemail. For the compliance test, Avaya IP Office is deployed in a 2-port
configuration. The Avaya IP Office LANL port is connected to the private enterprise LAN and
the WAN (LAN2) port is connected to the public network.
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Figure 1: Avaya Interoperability Test Lab Configuration
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For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been replaced with numbers
that cannot be routed over the PSTN.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to send digits
across the SIP trunk to Windstream. The short code of 9 is stripped off by Avaya IP Office and
the remaining digits were sent unaltered to Windstream. Windstream accepts 11 digits in the
Request-URI header for long distance and local calls. For inbound calls, Windstream sends 10
digits in the Request-URI.
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Software

Avaya IP Office 500 v2

9.1 SP3(9.1.3.0.120)

Avaya IP Office Manager

9.1 SP3(9.1.3.0.120)

Avaya IP Office VoiceMail Pro

9.1SP3(9.1.3.0.2)

Avaya 1140E IP Deskphone (SIP)

4.4 SP2 (4.04.18)

Avaya 16161 IP Deskphone (H.323) running 1.3.6 (1.3.60A)
Avaya one-X® Deskphone Value Edition

Avaya 9641G IP Deskphone (H.323) running 6.6.0 (6.6.0.29)
Avaya one-X® Deskphone Edition

Avaya Communicator for Windows 2.0.3.30

Windstream Components (Genband Platform)

Equipment

Software

Acme Packet Net-Net 4250 Session Border
Controller

SC6.2.0 Patch 3 (Build 497)

LCS Gateway

3.15.1.4

Genband C3/8000/G9

8.1

Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition

without T.38 Fax Service.

Avaya IP Office Server Edition requires an Expansion IP Office 500 V2 R9 to support

analog/digital endpoints or analog/digital trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - All Programs - IP Office - Manager to launch
the application. A screen that includes the following may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Oipen Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group Pane has been omitted, its content is shown as submenus in the Navigation
pane. The Navigation and Details panes will be referenced throughout the Avaya IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider (such as twinning and Avaya Communicator support) is assumed to
already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) appears

in the Details pane.

IP Offices £ - X| <>
@& BOOTP (2) License | Remote Server
-4 Operator (3) :
(=% Atlantic City License Mode License Normal
(-39 System (1)
{f,-.'ﬂ Line (18) Licensed Version 91
(-2 Control Unit (3) i
-4 Extension (25) Serial Number (ADI)
+ i User (27)
-8 Group (1) PLDS HostID
- @% Short Code (64) PLDS File Status Not Present / Invalid
; @ Service (0)
(s RAS (1)
‘i»--e Incoming Call Route (44)
i £ WAN Port (0) Feature License Key Instances Status y Add...
- Directory (0) " 5 »
L,“‘ Time Profile (0) 1P500 Voice Networking Channels 4 Valid Remove
& @ Firewall Profile (1) VCM Channel Migration 255 Valid . i
& IP Route (4) SIP Trunk Channels 255 Valid |
@@ Account Code (0) VPN IP Extensions 255 Obsolete
; :; 1P500 Universal PRI (Additional cha... 255 Valid
: unnel ) "
) §3 User Rights 8) RAS LRQ Support (Rapid Response) 255 Valid
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 8 of 38
SPOC 10/19/2015 ©2015 Avaya Inc. All Rights Reserved. WindGBIPO91




To view the physical hardware comprising Avaya IP Office, expand the components under the
Control Unit in the Navigation pane. In the sample configuration, the second component listed
is a Combination Card. This module has 6 digital stations ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary
to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices E IP 500 V2 i vie<l>

=- % BOOTP (2) Unit
[-4# Operator (3)
-5 Atlantic City Device Number 1

---L-':- System (1) )

-7 Line (24) Unit Type ——

== Control Unit (3)

o PR A Version 9.1.300.120

[#-48 Extension (25) . 1032128.35

[]"-a User (27) Unit IP Address

Dmﬁ Group (1) Interconnect Number 0

[=-8) Short Code (64)

""" B senice 0) Medule Mumber Control Unit

afs RAS (1)
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5.2. System

Configure the necessary system settings.

5.2.1. System — LAN2 Tab

In the sample configuration, the Avaya IP Office WAN port was used to connect to the public
network. The LAN2 settings correspond to the WAN port on the Avaya IP Office 500 V2. To
access the LAN2 settings, first navigate to System = <Name>, where <Name> is the system
name assigned to the Avaya IP Office. In the case of the compliance test, the system name is
Atlantic City. Next, navigate to the LAN2 - LAN Settings tab in the Details Pane. Set the IP
Address field to the IP address assigned to the Avaya IP Office WAN port on the public
network. Set the IP Mask field to the mask used on the public network. All other parameters
should be set according to customer requirements.

IP Offices |

X

= Atlantic City

- & BOQTP (2)

i Operator (3)

=7 Atlantic City

1553 System (1)
g Atlantic City

-4 Line (20)

F-=2 Control Unit (3)

(-4 Extension (25)

[

[

[

H-§  User (27)

Jﬁ Group (1)

£-@% Short Code (54)

----- B Senvice (0)

F-alfy RAS (1)

E]---@ Incoming Call Route (5
----- BB WAN Port (0)

----- @z Directory (0)

£ Time Profile (0)

(@8 Firewall Profile (1)

SMDR | Twinning | VCM | Codecs | WVolIP Security | Contact Center|
System | LANL | LANZ | DNS | Voicemail | Telephony | Directory Services | Systern Events | SMTP |

LAN Settings | VolP | Network Topology|

IP Address 192 168 96 232

IP Mask 255 255 255 224

Primary Trans. IP Address 0 0 0 0

Firewall Profile | <Nene> -

RIF Mode [None vl
[7] Enable MAT

MNumber Of DHCP IP Addresses (200 |2

-l 1P Route () DHCP Made
""" #m Account Code (0) () Server () Client () Dialin @ Disabled Advanced
----- % License (78)
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On the VolIP tab in the Details Pane configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e The RTP Port Number Range can be customized to a specific range of ports that Avaya
IP Office will use for RTP media. This port range will be used to select a destination port
for incoming RTP and a source port for outgoing RTP for calls using LANZ2.

i= Atlantic City o v | <>

Contact Center

System | LAMNL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | VCM | Codecs | VolP Security

-LAN Settings | VoIP | Network Topology

H323 Gatekeeper Enable
[ Auto-create Extn Auto-create User [T H323 Remote Extn Enable

1720

SIP Trunks Enable

m

SIP Registrar Enable
[[] Auto-create Extn/User [] SIP Remote Extn Enable

Domain Mame

upp UDP Pert 5060 = 5060
Layer 4 Protecol TCP TCP Port  |5060 = 5060
[] TLS TLS Port (5061 = 5061
Challenge Expiry Time (secs) 10 =
RTP
Port Mumber Range
Minimum 49152 = Maximum 53246 =
Port Mumber Range (MAT)
Minimum 49152 = Maxdimum 53246 =
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Scroll down the page.

e Inthe Keepalives section, set the Scope to RTP. Set the periodic timeout to 30 and the
Initial keepalives parameter to Enabled. These settings will cause Avaya IP Office to
send a RTP keepalive packet starting at the time of initial connection and every 30
seconds thereafter if no other RTP traffic is present. This facilitates the flow of media in
cases where each end of the connection is waiting to see media from the other, as well as
helping to keep firewall ports open for the duration of the call.

¢ Inthe DiffServ Settings section, Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test were the Avaya IP Office default values and are
shown in the screenshot below. Quality of Service (QoS) is not specifically tested as part
of the compliance test. For a customer installation, the DSCP and SIG DCSP fields
should be set as directed by the customer or service provider.

e All other parameters should be set according to customer requirements.

Atlantic City

Contact Center

System | LAMNL | LAN2 | DINS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | VCM | Codecs | VolP Security

LAN Settings | VoIP

Metwerk Topelagy

Enable RTCP Menitering on Port 5005

RTCP collecter IP address for phones

Primary 5ite Specific Option Mumber (550N)
Secondary Site Specific Option Mumber (350N)

VLAN

1100 Voice VLAN IDs

1100 Veice VLAM Site Specific Option Number (550N} 232 =

Keepalives

Scope lRTP VI Periodic timeout 30
Initial keepalives lEnabIed VI

DiffServ Settings

B8 =| DSCP(Hex) |B8 =| Video DSCP(Hex) [FC = DSCP Mask (Hex) 88 = SIG DSCP (Hex)
46 = DscP 46 | Video DSCP 63 = DSCP Mask 34 *| SIGDSCP
DHCP Settings

176 =

242 =

-

Mot Present -

-

m
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On the Network Topology tab in the Details Pane, configure the following parameters:

Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used
between the Avaya IP Office and the public network, the parameter was set to Open
Internet.

Set Binding Refresh Time (seconds) to 300. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.

Set the Public IP Address to the IP address assigned to the Avaya IP Office WAN port
in the LAN2->LAN Settings form earlier in this section.

In the Public Port section, next to the transport protocol UDP, select the UDP port on
which Avaya IP Office will listen.

All other parameters should be set according to customer requirements.

X

= Atlantic City £

VCM | Codecs | VoIP Security | Contact Center|

System | LAML | LANZ |DNS | Voicemail | Telephony | Directory Services | System Eventsl SMTP | SMDR | Twinning |

| LAN Settings | VoIP | Network Topology |
Metwork Topology Discovery
STUM Server Address 10.90.168.13 STUM Port 3478 =
Firewall/NAT Type [Open Internet v]
Binding Refresh Time (seconds) 300 =
Public IP Address 192 168 96 232 Run 5TUMN Cancel
Public Port
upp 5060 =
TCP 0 =
LS 0 =
[T Run STUN on startup
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony = Telephony tab in the
Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be allowed to
transfer back to the PSTN then leave this setting checked.

®

= Atlantic City £ v | <>

VolP Security | Contact Center|
System | LANI | LAN2 | DNS | Voicemail | Telepheny | Directory Services | System Events | SMTP | SMDR | Twinning | VCM | Codecs |

Telephony | Park & Pagel Tones & Musicl Ring Tones | SM | Call Log | TUI |

»

Analogue Extensions Companding Law —
Switch Line
Default Qutside Call Sequence [Normal v]
Default Inside Call Sequence [Ring Typel v] @ U-Law @ U-Law Line
Default Ring Back Sequence [Ring Type 2 vl
. ) ) ) A-Law ) A-Law Line
Restrict Analogue Extension Ringer Voltage &

= [ DSS Status

Dial Delay Time (secs) 4 =
= V| Aute Hold
Dial Delay Count 0 v Hhe e
= Dial By Mame
Default Mo Answer Time (secs) 25 = :
) = Show Account Code
Hold Timeout (secs) 0 =
|:| Inhibit Off-Switch Ferward/Transfer L
Park Timeout (secs) 300 = =
[T Restrict Metwork Interconnect
Ring Delay (secs) 5 o
- Include lecation specific infermation
Call Priority Promotion Time (secs) |Disabled = -
Drop External Only Impromptu Conference
Default Currency usD hd
[ ] [T] Visually Differentiate External Call
Default Mame Priority Favor Trunk -
’ ] [] Unsupervised Analog Trunk Disconnect Handling
Media Connection Preservation lDisabIed v] ) ) )
High Quality Conferencing
Phone Failback ’Manual v] .
Digital/Analegue Auto Create User

Legin Code Complexity B
Directery Overrides Barrin
[T Enforcement v g

Complexity | 4
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5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
Pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party
information for Mobile Twinning is left blank. Click the OK button at the bottom of the page

(not shown).

o

= Atlantic City

VCM | Codecs | VolP Security | Contact Center|

System | LANL

LAMZ | DNS | Vioicemail | Telepheny | Directory Services | System Events | SMTP | SMDR | Twinning
pheny ry ¥

[] Send original calling party information for Mobile Twinning
Calling party information for

Mobile Twinning

5.3. IP Route

A default route is needed so IP Office can reach other network subnets other than the one where
it resides. Navigate to IP Route = 0.0.0.0 in the left Navigation Pane if a default route already
exists. Otherwise, to create the default route, right-click on IP Route and select New.

Create/verify a default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the default router on the public network
where Avaya IP Office is connected.

e Set Destination to LAN2 from the drop-down list.

Click the OK button at the bottom of the page (not shown).

IP Offices || i= 0.0.0.0 S X v <>
=- K BOOTP (2) IP Route
-4 Operator (3)
-3 Atlantic City IP Address 0 0 .0 0
[H-559 System (1)
17 Line (20) IP Mask o . 0 .0 .0
<2 Control Unit (3) Gateway IP Address 192 . 168 . 96 . 254
48 Extension (25)
w-§ User 27) Destination LAN2 -
E-5§ Group (1) -
-8 Short Code (64) Metric 0 =
----- B Service (0)
-, RAS (1) [T Proxy ARP

I:I-"@ Inceming Call Route
----- BB WAN Port (0)

----- @2 Directory (0)

£ Time Profile (0)

E-@8 Firewall Profile (1)
Bn IP Route (4)
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the
Windstream SIP Trunking Service. The recommended method for configuring a SIP Line is to
use the template associated with these Application Notes. The template is an .xml file that can
be used by IP Office Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create
the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 — 5.4.8.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls

e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required
e SIP Advanced

e Engineering

To create a SIP Line manually, right-click Line in the Navigation Pane and select New = SIP
Line; then, follow the steps outlined in Sections 5.4.2 — 5.4.8.
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5.4.1. SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to a name with the following format
AF_<user_supplied_text> SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5. The example used in these Application Notes is
AF_Windstream-noSBCE_SIPTrunk.xml.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. Inthe IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable
Template Options. Click OK.

=
" IP Office Manager Preferences [ilé

1
|

] Preferences I Directories I Discovery | Visual Preferences iSecurity l Validationi

Icon Size ISmaIl vl

[¥] Multiline Tabs

[¥] Enable Template Options

["] Enable Template Creation

i) 0K ‘ ’ Cancel ’ ’ Help

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager. This action will copy the template file into the IP
Office template directory and make the template available in the IP Office Manager pull-
down menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

3 3 (C Extension Renumber... ’
P omce_ Line Renumber... =
. Connect To... —|
#-#®& BOOTP (1)
i-47 Operator (3) Expost *
=-%% Atlantic City SCN Service User Management
5% Syst
-5 Liy:ee(rlr;)(l) Busy on Held Validation
- Control Unit MSN Configuration
i+ Extension (2
ii:*"i User (27) Print Button Labels
5§ Group (1) ‘ Import Templates in Manager
(+-8% Short Code (037 e
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In the pop-up window that appears (not shown), select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window will appear stating success or failure (not shown). Click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to
the IP Office template directory.

Note —Windows 7 (and later) locks the Avaya IP Office 9.1 \Templates directory, and it
cannot be viewed. To enable browsing of the \Templates directory, open Windows
Explorer, navigate to C:\Program Files\Avaya\lP Office\Manager (or C:\Program
Files (x86)\Avaya\lP Office\Manager), and then click on the Compatibility files option
shown below. The \Templates directory and its contents can then be viewed.

@Qv! » (Eomputer » Local Disk(F:) » Program Files » Avaya » IP Qﬁice » Manager » - . v ]Z_L
—— _ = = —
Organize v Include in library v Share with v Burn New folder
A Favorites Name : Date modified Type
B Desktop de-DE File folder
& Downloads en-US File folder
| Recent Places es-MX File folder
fr-FR File folder
- Libraries IPSET-UNISTIM-C7M File folder
:;i Documents ) it-IT File folder
' Music LVMGreeting File folder
k| Pictures MemoryCards File folder
B Videos nl-NL 10/20/2014 1 File folder
Phonelmages 0/20/201410:08 ...  File folder
*& Homegroup pt-BR File folder
ru-RU 0 File folder
1% Computer V3.2.999 10/20/2014 10:08 .., File folder
&l Local Disk (C:) | zh-Hans 10/20/201410:08 ...  File folder
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CTM; Reviewed:
SPOC 10/19/2015

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,

and select New SIP Trunk F

rom Template.

IP Offices

-
-
o

SIP Line

=-K& BOOTP (2)
;7 Operator (3)

SIP Line Transport|SIP URI|VolP | T38 Fax|SIP Creq

MNew

4

=55 Atlantiq

Mew SIP Trunk from Template

E
e

-2 Cor
-4y Exte
g Use X
-4 Gro
E

H-B% She

H-El PR

Create SIP Trunk Template

Cut Crl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Ctrl+Del
Validate

Connect Tou., Ctrl+T

Mew from Template (Binary)
Export as Template (Binary)

21

woip.sotel

SIP

Cloud

----- M AccounTCouETT | Calnty Code

00

5. In the subsequent Template Type Selection pop-up window, use the Service Provider
pull-down menu to select the XML template file created in Step 1. This menu will
display the <user_supplied_text> portion of the file name of each template located in the
directory. Select the entry that corresponds to the desired file name. In the case of this
example, Windstream-noSBCE was selected, corresponding to a file name of
AF_Windstream-noSBCE_SIPTrunk.xml. Click Create new SIP Trunk to finish

creating the trunk.

fe -
™ Template Type Selection = Iﬂs.J
Locale Inited States (LIS English]
Service Provider | Windstream-noSBCE v] (] Display All

l Create new SIP Trunk J ( Cancel

l

.

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.4.2 — 5.4.8.
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5.4.2. SIP Line — SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

e Set ITSP Domain Name to the IP address of the Windstream SIP proxy.

e Check the In Service box. This makes the trunk available to incoming and outgoing
calls.

e Check the Check OOS box. Avaya IP Office will use the SIP OPTIONS method to
periodically check the SIP Line. The time between SIP OPTIONS sent by Avaya IP
Office will use the Binding Refresh Time for LANZ2, as shown in Section 5.2.1.

e Set the Refresh Method to Auto and the Timer (seconds) to 600. In the case of
Windstream, this will cause Avaya IP Office to send an UPDATE message every 300
seconds (1/2 the Timer value) to check the state of each active session.

e Set Send Caller ID to Diversion Header. With this setting and the related configuration
in Section 5.2.3, Avaya IP Office will include the Diversion header for calls that are
directed via Mobile Twinning out the SIP Line to Windstream. It will also include the
Diversion header for calls that are call forwarded out the SIP Line.

e Issues were observed with the use of the SIP REFER method (Section 2.2). Thus, the use
of REFER should be disabled. Under Redirect and Transfer, set the Incoming
Supervised REFER field and Outgoing Supervised REFER field to Never.

e Default values may be used for all other parameters.

Pomces  [[Z - LR LI o-3 X v

4 R 9:':‘”"-"_ AP Line Transport| S8 URS | VolP | 138 Fax| SP Credentunls | SIP Advanced  Engmeenng

it Nurmber B - In Service

£} TS Domain Name 1521681118 Check OGS
UKl Type @ = son Timers
Cheud - Refresh Methoo L0
Titner (seconds) 00
y Formardng and 7 g
ationa! Prelis 0 Orginatoe numbe:
Send Caier ID Dwversion Header -

cming Supervised FEFER
MName Priority Systerm Default = [ncomeng Supervised REFE Never -

Qutgaing Superveed REFER Hever -

stion Reguest Sendd 307 Meved Temgcrarily

HEVATRIIRG ) GOFBIA™S

Outgeing Bind REFER
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5.4.3. SIP Line - Transport Tab
Select the Transport tab. Set or verify the parameters as shown below.

e Set the ITSP Proxy Address to the IP address of the Windstream SIP proxy.

e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to the network port used by the SIP line to access the
far-end and configured in Section 5.2.1.

e Set the Send Port to 5060.

e Default values may be used for all other parameters.

= SIP Line - Line 31 ek -0 X | v <>

SIP Line| Transport |SIP URI|VolP | T38 Fax|SIP Credentials |SIP Advanced |Engineering|

ITSP Proxy Address  19216811.151

Metwork Configuration

Layer 4 Protocol [UDP v] Send Port 5080 =
Use Metwork Topology Info [LAN 2 v] 5060
Explicit DS Server(s) 0 0 0 0 a ] ] 0

Calls Route via Registrar

Separate Registrar
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5.4.4. SIP Line — SIP Credentials
Windstream does not require registration so the SIP Credentials tab has no entries.

= SIP Line - Line 31 el - X v <>
|SIP LinelTransportlSIP URIlVoIP |T38 Fax| SIP Credentials |SIP Ad?ancedlEngineering|
Index UserMame Authentication Mame Contact Expiry (mins) Register Add...
Remowve
Edit...
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 22 of 38

SPOC 10/19/2015 ©2015 Avaya Inc. All Rights Reserved. WindGBIPO91



5.4.5. SIP Line - SIP URI Tab

A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit button. In the example screen below, a new entry is created. The
entry was created with the parameters shown below:

Set Local URI to Use Internal Data. The Local URI parameter controls which calls
will be accepted by the system on this SIP URI and also defines the contents of the From
header for outbound calls. The setting of Use Internal Data will enable the User = SIP
tab for each Avaya IP Office user where the SIP information can be configured. The
setting of Use Internal Data will allow inbound calls whose user portion of the incoming
Request-URI matches a value configured on the system for a user (User = SIP), hunt
group (Hunt Group = SIP) or voicemail (System = Voicemail). For outbound calls,
the From header is populated with the SIP Name configured for the user (Section 5.7).
Set Contact, and Display Name to Use Internal Data. This setting will populate each
of these headers with the corresponding value from the User = SIP tab of the Avaya IP
Office user involved in the call. See Section 5.7.

Set PAI to None.

For the Registration field, select 0:<None> from the pull-down menu.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8.1. Similarly, associate the line to an outgoing line
group using the Outgoing Group field. The outgoing line group number is used in
defining ARS entries for routing outbound traffic to this line in Section 5.5. For the
compliance test, a new incoming and outgoing group 31 was defined that only contained
this line (line 31).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
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W

Mew Channel

= SIP Line - Line 31 ef -# X v <>

SIP LinelTransport 5IP URI ‘VOIP |T38 FaxlSIP CredentialslSIP Advanced Engineering‘

Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls Add...
Remove
Edit...

Via 192.168.96.232
Local URI Use Internal Data -
Contact Use Internal Data -

Display Mame Lse Internal Data -

PAT Mone -

Registration 0: <Mone> -

Incoming Group 31

Outgoing Group 31

Max Calls per Channel 10 =

Additional SIP URIs may be required to allow inbound calls to numbers not associated with a
user, such as a short code. These URIs are created in the same manner as shown above with the
exception that the incoming DID number is entered directly in the Local URI, Contact, and
Display Name fields.
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5.4.6. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

For Codec Selection, select Custom from the pull-down menu to use a custom list of
codecs. Next, move unwanted codecs from the Selected column to the Unused column if
needed. Lastly, move the codecs up or down the list in the Selected column to achieve
the desired order of preference. The example below shows the codecs used for the
compliance test. This codec order was used to match the codec order used by
Windstream as close as possible.

Uncheck the VolP Silence Suppression box.

Check the Re-invite Supported box.

Set the Fax Transport Support to G.711. Windstream does not support T.38 fax.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

e

SIP Line - Line 31 e - X v <l

|SIP LinelTransportlSIP URI| ValP |T38 FaxlSIP CredentialslSIP AdvancedlEngineering|

Codec Selection "Custom v] [[] Codec Lockdown
Unused Selected [7] Allow Direct Media Path
vas | [6729(z) BK CS-ACELP _ o
G711 ULAW 64K Force direct media with phones
G711 ALAWG4K [C] PRACK/100rel Supported

[T] VolIP Silence Suppression

Re-invite Supported

G.7231 6K3 MP-MLQ
[[] G.711 Fax ECAN

ES-5

Fax Transport Support lG.?ll v]
DTMF Support |RFC2833 -
Media Security |Disabled -
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5.4.7. SIP Line — T38 Fax Tab

Select the T38 Fax tab. Since Windstream does not support T.38 fax, the T.38 settings are left at
the default values.

EE ﬂt - [ﬂ b S I A - ]
'SIP Line|Transport| SIP URI|VolP | T38 Fax SIP Credentials|SIP Advanced |Engineering
T38 Fax Version |3 - |
[/] Scan Line Fix-up
Transport |UDPTL v|

[7] TFOP Enhancement

Redundancy
[ ] Disable T30 ECM

e |U - | [] Disable EFlags For First DIS

High Speed |U - | |:| Disable T30 MR Compression
TCF Method |TransTCF v| [ MSF Override
Max Bit Rate (bps) 14400 - Country Code (0 :
EFlag Start Tirner (msecs) |26[][] z | Vendor Code |':J =

EFlag Stop Timer (msecs) |BUU : |

Tx Metwork Timeout (secs) |15|:| = |

[7] Use Default Values
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5.4.8. SIP Line — SIP Advanced
Select the SIP Advanced tab. Set the parameters as shown below.

Check the Use PAI for Privacy box. If PAI is set to None on the SIP Line = SIP URI
tab, then by default Avaya IP Office will send the P-Preferred-Identity (PPI) header when
placing a privacy call. Checking this option will cause Avaya IP Office to send the P-
Asserted-Identity (PAI) header instead.

Check the Emulate NOTIFY for REFER box. Strictly speaking, this is only necessary
if REFER is enabled on the SIP Line to the service provider (Section 5.4.2). Since it is
recommended that REFER is disabled for this solution, this setting is enabled simply as a
precaution if REFER is enabled in the future. With REFER enabled, the Avaya 1100
Series Deskphones and Avaya Communicator for Windows expects to receive a NOTIFY
message to indicate that the referred (i.e., transferred) call was successful. If the
NOTIFY is not received from the far-end, then the call display will indicate that the
transfer failed even if the transfer was successful. If the Emulate NOTIFY for REFER
box is checked, then Avaya IP Office will send a NOTIFY message (on behalf of the far-
end) to the Avaya 1100 Series Deskphones and Avaya Communicator for Windows.

Click the OK button at the bottom of the page (not shown).

Call Routing Method |Request URI v|
Allow Te Tag Change
Suppress DMNS SRV Lookups P-Early-Media Suppart ||"‘|0"1E v|
Send SilenceSupp=Off
Identity
Use Phone Context Media Connection |Disabled v|
Add user=phone Preservation
Use + for International
Use PAI for Privacy v Call Control

Use Domain for PAI
Swap From and PAI

Caller ID from From header Call Queuing Timeout (m) |3
Send From In Clear Service Busy Response |486 - Busy Here vl
Cache Auth Credentials Pl

User-Agent and Server Headers Send

= SIP Line - Line 31 ef -8 [ X wl<]|>
|SIP LinelTransportlSIP URIl‘u‘oIP |T38 FaxlSIP Credentia|s| SIP Advanced |Engineering|
Addressing Media
Association Method | By Source IP address v| Allow Empty INVITE

Send Empty re-INVITE

Call Initiation Timeout (s) 4

-
-

on Mo User Respending |408-RequestTimeout v|

Action on CAC Location

- |Allow‘u’oicemail vl
Limit

Suppress Q.850 Reasen
Header

Emulate MOTIFY for REFER. [/
Mo REFER if using Diversion
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5.5. Alternate Route Selection (ARS)

Alternate Route Selection (ARS) is used to route outbound traffic to the SIP line. To define a
new ARS route, right-click ARS in the Navigation pane and select New. In the Details pane that
appears, a collection of matching patterns (similar to short codes) can be entered to route calls as
shown below.

For the compliance test, two entries were created. The first entry matches on 0 and the second
entry matches on any other number N.

To create an entry, click the Add button and enter the following in the pop-up window (not
shown).

e Inthe Code field, enter the pattern to match the number passed to ARS from the short
code in Section 5.6 followed by a semi-colon. The value N will match any number.

e Set Feature to Dial. This is the action that the entry will perform.

e For Code 0, set Telephone Number to 0”@ipaddr”, where ipaddr is the Windstream
SIP proxy IP address provided by Windstream and used to configure the trunk in Section
5.4.2. Adding the IP address in this field was required to ensure that the correct host
appeared in the outbound Request-URI header when dialing 0. This was not required
when matching on any other dialed number as shown next.

e For Code N;, set Telephone Number to N. This field is used to construct the Request-
URI and To headers in the outgoing SIP INVITE message. The value N represents the
complete number passed to ARS.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.4.5. This entry will use this line group when placing the
outbound call.

Click the OK button (not shown).

1§
2
b4
<

Dual Dedary Time Systemn Defauk 4) 2 Check User Cal Berning

Code Telephone Humber Feature Line Geoup 10 Add..

FIATRIIRG ) GOMDIE™H ' 2
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5.6. Short Codes

A short code is a dial pattern that triggers a specific function. A short code is used by the caller
to route outbound traffic to ARS. To create a short code, right-click on Short Code in the
Navigation Pane and select New. On the Short Code tab in the Details Pane, configure the

parameters as shown below.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9

followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.

e Setthe Line Group ID to the ARS route to be used (Section 5.5).

Click the OK button (not shown).

IP Offices = 9N;: Dial S X v <>

= ® BOOTP (2) Short Code
-4 Operator (3)
=I-*27 Atlantic City Code 9n;

%59 Systemn (1)

+‘T‘. Line (24) Feature Dial hd

-2 Contrel Unit (3)

+@ Extension (25) Telephone Number M

:% E:LSQ) Line Group ID 59: Windstream -

+-@% Short Code (64) Local -

4B Service (0) e I

+,\gf RAS (1) Force Account Code [

+e Incoming Call Route (66| oo 4 thorization Code [

8@ WAN Port (0)
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”.

In the case of the SIP Line documented in these Application Notes, when a user dials *67 plus
the number, Avaya IP Office will include the calling number in the P-Asserted-Identity (PAI)
header and will include the Privacy: Id header.

h= *67N;: Dial £ - X | wv|l<|>
Short Code

Code *BTM:

Feature Dial -

Telephone Mumber WH

Line Group ID 59: Windstream -

Locale ’ -

Force Account Code =

Force Authorization Code  [7]

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 30 of 38
SPOC 10/19/2015 ©2015 Avaya Inc. All Rights Reserved. WindGBIPO91



5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User - Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Extn243. Select the SIP tab in the Details Pane. The values entered for the
SIP Name and Contact fields are used as the user part of the SIP URI in the From and Contact
headers for outgoing SIP trunk calls and allow matching of the SIP URI for incoming calls
without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4.5). The
example below shows the settings for user Extn243. The SIP Name and Contact are set to one
of the DID numbers assigned to the enterprise from Windstream. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name. If all calls involving
this user and a SIP Line should be considered private, then the Anonymous box may be checked
to withhold the user’s information from the network.

Click the OK button (not shown).

1= Extn243: 243 - X v

User Voicerned | DND Shert Codes | Source Numbery | Teleghony = Forwarding | Disfin | Vouce Recordng | Button Progeemmung
Merw Programming | Mabilty | Group Membesship | Announcements 5P Personal Dicectory | Web Self-Administration
5P Neme Jarsssiag
SP Oisplay Name (Alias) Bdn243
Contact 7a75551234

# B Shon Code (64)

a Serace [0} Amonymous
ol RAS1)
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and
select New.

5.8.1. Incoming Call Route — Standard Tab
On the Standard tab of the Details Pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.

e Setthe Line Group Id to the incoming line group of the SIP line defined in Section
5.4.5.

e Set the Incoming Number to the incoming number on which this route should match.

e Default values can be used for all other fields.

IP Offices = 31 7575551234 ef - K v <>
“ BOOTP (2) Standard | Vaoice Recording | Destinations|
{7 Operator (3)
-39 Atlantic City
-5 System (1) Bearer Capabili Any Voice -
E-17 Line (24) pebiliy [any l
[#-=r Control Unit (3) Line Group ID Exl -
-4 Extension (25)
E-§  User (27) Inceming Number 7575551234
E-58 Group (1)
[-BX Short Code (54) Incoming Sub Address
----- B senvice (0) .
-, RAS (1) Incoming CLI
-3 Incoming Call Route (68 Locale [ ,l
----- B2 WAN Port (0)
""" s Directory (0) Priority 1-Low -|
- Time Profile (0}
EJ---@ Firewall Profile (1} Tag
[-Jill IP Route (4)
..... #m Account Code (0) Hald Music Source ’S},rstem Source ']
----- & License (78) . . N
_____ W Tunnel (0) Ring Tene Override one -

5.8.2. Incoming Call Route — Destinations Tab

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to
7575551234 on line 31 are routed to extension 243.

- 31 7575551234 £ - K & <
Standard | Voice Recording | Destinations
TimeProfile Destination Fallback Extension
» | Default Value 243 Extn243 =l v
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Incoming Call Routes for other direct mappings of DID numbers to Avaya IP Office users listed
in Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

rSave Configuration l =1 ‘&r

IP Office Settings

Atlantic City

Configuration Reboot Mode
@ Merge
1 Immediate

1 When Free
() Timed

Reboot Time

09:25

Call Barring

| ok || cancel || Help
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6. Windstream SIP Trunking Service Configuration

Windstream is responsible for the configuration of the Windstream SIP Trunking Service. The
customer will need to provide the IP address used to reach the Avaya IP Office at the enterprise.
In the case of the compliance test, this is the public IP address of the Avaya IP Office WAN port.
Windstream will provide the customer the necessary information to configure Avaya IP Office
including:

e Windstream SIP proxy IP address
e Transport protocol and port
e DID numbers

7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

7.1. System Status

The System Status application is used to monitor and troubleshoot Avaya IP Office. Use the
System Status application to verify the state of the SIP trunk. System Status can be accessed
from Start = All Programs > IP Office = System Status.

The following screen shows an example Logon screen. Enter the Avaya IP Office private IP

address in the Control Unit IP Address field, and enter an appropriate User Name and
Password. Click Logon.

AV, y IP Office System Status

Help Exit About

Online  Offline

Logon

Control Unit IP Address: PlRySyiNi)

Services Base TCP Port: E:LES

U ETG T Administrator

[ Auto reconnect
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify

the Current State is Idle for each channel.

IP Office System Status

Status  Utiization Summary Alarms

SIP Trunk Summary
Line Service State: In Service
Peer Domain Mame: 192.1668.11.151
Resolved Address: 192.168.11.151
Line Mumber: 31
Mumber of Administered Channels: 10
Mumber of Channels in Use: i}
Administered Compression: G729 A, G711 Mu, G711 A, G7231
Enable Faststart: off
Silence Suppression: Off
Media Stream: RTP
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: Unlimited . 0%
SIP Trunk Channel Licenses in Use: i}

SIP Device Features:

urrent Timein Re Co... Conne... Caller ther Party on tion Round

Transmit Tr,

e e  State A... or all Il TripD.. . Jitter Pai
1 Ide |02:48...
2 Ide [02:48...
3 Ide |1day...
4 Ide |1day...
5 Ide |i1day...
[ Ide |i1day...
7 Ide |1day...
8 Ide |1day...
g Ide |i1day...
10 Ide |i1day...
Trace [ Trace Al ] [ Pause ] [ Ping ] Call Details Graceful Shutdown ] [ Force Out of Service ] [ Print...

Select the Alarms tab and verify that no alarms are active on the SIP line.

g Alarms

a

tatus  Utilization Summary

Alarms for Line: 31 SIP 192.168.11.151

Last Date Of Error Occurrences Error Description
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7.2. Monitor

The Monitor application can also be used to monitor and troubleshoot Avaya IP Office. Monitor
can be accessed from Start = All Programs = IP Office = Monitor. The application allows
the monitored information to be customized. To customize, select Filters = Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring.

All Settings S

T1 | WPN | WA | SCN | Jade |
aTM | cal | DTE | ECorf | FrameRelay | GOD | H323 | Interface |
ISDM ] Keya’Lamp] Directary ] Media ] PPP ] R2 ] Houting] Services  SIP l System]

Ewents

W Sip |Standad « v STUN [~ SIP Dect
Packets
[~ SIF Reg/Opt Rx [ SIP Misc Rx
[~ SIP Rea/Opt Tx [~ SIP Misc Tx
[~ SIP Call Rx [~ Crmn Matify Rx
[~ SIPCall T [ Crn Matify Tx
v Sip R« IP Filker [nim.nnn.nnn. nnn)
¥ Sip T |

Cancel

Default All ‘ Clear All | Tab Clear &l ‘ Tab Set all |

T ‘ Load File | LoadPartiaIFiIe‘ SelectFiIe|

8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 9.1 to
the Windstream SIP Trunking Service (Genband Platform). The Windstream SIP Trunking
Service is a SIP-based Voice over IP solution for customers ranging from small businesses to
large enterprises. It provides a flexible, cost-saving alternative to traditional hardwired
telephony trunks. The Windstream SIP Trunking Service (Genband Platform) passed
compliance testing. Please refer to Section 2.2 for any observations/exceptions.
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9. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] Deploying Avaya IP Office Platform IP500 V2, Document Number 15-601042, Issue 30,
August 12, 2015.

[2] Administering Avaya IP Office Platform with Manager, Issue 10.21, August 2015.

[3] Using System Status, Document Number 15-601758, Issue 10f, August 11, 2015.

[4] Administering Avaya IP Office Voicemail Pro, Document Number 15-601063, Issue 10f, July
10, 2015.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 06e, May 19, 2015.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and
™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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